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Abstrak
Sejak zaman dahulu pintu merupakan alat pengaman  penting dalam sebuah bangunan baik berupa rumah atau bangunan yang lain seperti perkantoran dan lain lain. Terkadang untuk membuka dan menutup pintu rumah atau bangunan lain sering  mengalami kesulitan. Perkembangan teknologi saat ini dapat menggantikan pintu manual ini menjadi sistem otomatis. Untuk mengantisipasi masalah keamanan  perlu juga diperhatikan sistem keamanan pintu otomatis. Penelitian ini merumuskan permasalahan bagaimana sistem pintu otomatis dan keamanan pintu dengan menggunakan RFID. Metode penelitian yang digunakan adalah riset dan pengembangan. Pintu Otomatis ini diprogram oleh aplikasi Arduino dengan membuat sistem keamanan menggunakan Radio Frequency indentification (RFID) sebagai gelombang radio frekuesi pembawa data yang akan diterima receiver. dan membrane keypad sebagai pengganti Card RFID bila user tidak membawa kunci. Hasil Penelitian ini berupa prototipe yang menghasilkan fitur yang ada dalam sistem tersebut antara lain Arduino sebagai Kontroler dan Passive Intra red sebagai antarmuka instruksi, Motor servo sebagai output
  Kata Kunci : Arduino, RFID, Prototype, otomatis

Abstract
Since the beginning of time, doors have been a vital component of safety in all kinds of constructions, including homes and other types of buildings like offices and others. It could occasionally be difficult to open and close a door to a home or other building. Recent technological developments have made it possible to replace this manual door with an automation system. In order to anticipate security difficulties, it's crucial to pay attention to the automatic door security system. This study formulates the problem of how to construct automatic doors and door security using RFID. The research process used is research and development. In order to program this automatic door, the Arduino application provides a security system using Radio Frequency Identification (RFID) as a data carrier radio frequency wave to be received by the receiver. if the user doesn't have a key on them, an RFID Card can be used instead of a membrane keypad. A system prototype that uses an Arduino controller, passive infrared as an instruction interface, and servo motors as an output serves as a visual representation of the study's findings.
Keywords : Arduino, RFID, Prototype, auto
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1. PENDAHULUAN
Sekolah merupakan salah satu sarana umum yang banyak dikunjungi orang, disisi yang lain saat ini kondisi pandemi yang belum sepenuhnya berakhir. Untuk meminimalkan kontak langsung dengan benda seperti membuka dan menutup pintu, maka diperlukan alat yang dapat membuka dan menutup pintu secara otomatis. 
Penggunaan teknologi sistem informasi menjadi kebutuhan manusia dan memberikan manfaat besar terhadap perubahan pada suatu struktur dan manajemen organisasi (Firdaus, Maulani, & Dharmawan, 2021). Dalam masa pandemi Covid-19 sekarang ini yang masih belum sepenuhnya berakhir, Masyarakat harus memikirkan bagaimana caranya agar mengurangi resiko terhadap penyebaran Covid-19 tersebut,  salah satunya adalah  dengan cara membuat pintu otomatis. Contohnya, untuk membuka pintu secara otomatis tanpa harus menyentuhnya. Dalam metode ini peneliti menciptakan sebuah alat untuk membuka pintu secara otomatis dengan menggunakan kartu RFID (Radio Frequency Identification). 
Hanya orang – orang tertentu yang bisa masuk ke dalam sebuah kantor di Sekolah yang sudah memiliki kartu yang telah didaftarkan pada database, oleh karena itu tidak sembarang orang bisa masuk, dengan hal ini juga dapat mengontrol secara detail siapa saja dan waktu yang akurat karna dalam sistem ini juga menghasilkan laporan setiap tap kartu RFID semua terdata dengan rinci waktu dan juga data pemilik kartu.
Sistem RFID terdiri dari tiga komponen utama yaitu tag atau transponder, pembaca dan database. Tag RFID besskerja sebagai objek pengenal yang di dalamnya ada data. Pembaca RFID reader yang digunakan pada sebagai informasi pada tag RFID. Database sebagai repository informasi dengan objek yang dimiliki oleh tag RFID. Arduino Uno adalah sebagai database dan memroses data yang diperoleh pada RFID. Kunci pintu akan terbuka otomatis jika tag RFID yang dibacakan oleh RFID reader sesuai dengan database.

2. Meode Penelitian
Metode yang digunakan pada penelitian ini adalah metode Riset dan pengembangan. Metode ini diterapkan pada prosedur penelitian berikut ini (1). Analisa kebutuhan, (2).Perancangan penelitian, (3).Perancangan perangkat keras, (4).Perancangan perangkat lunak
2.1. Analisa Kebutuhan
Dalam uji coba pembuatan alat ini diperlukan beberapa komponen, hal yang paling penting menentukan adalah kelengkapan komponen, tata letak komponennya. Adapun komponen yang dibutuhkan dan digunakan adalah sebagai berikut :
1. RFID RC522 sebagai input dan output gelombang frekuensi berupa radio.
2. Mikrokontroler Atmega 328 sebagai mikroprosesor lengkap yang terdapat di dalam sebuah chip.
3. Arduino sebagai pengendali system secara keseluruhan dan telah diprogram
4. Liquid Crystal Display (LCD) merupakan sebuah komponen yang digunakan untuk menampilkan tampilan dengan bahan berupa kristal 	cair
5. Relay adalah saklar elektrik yang menggunakan elektromagnetik untuk memindahkan saklar dari posisi OFF ke posisi ON. Daya yang dibutuhkan untuk mengaktifkan relay relatif kecil. Namun, relay dapat mengendalikan sesuatu yang membutuhkan daya lebih besar
6. Buzzer biasa digunakan sebagai indikator bahwa proses telah selesai atau terjadi suatu kesalahan pada alat
7. “Solenoid adalah aktuator yang mampu melakukan gerakan linier. Solenoid dapat berupa elektromekanis (AC/DC), hidrolik atau pneumatik. Perbedaan antara solenoid dan motor adalah bahwa solenoid adalah motor yang tidak dapat berputar
8. Motor Servo merupakan motor listrik dengan menggunakan sistem closed loop, Sistem tersebut digunakan untuk mengendalikan akselerasi dan kecepatan pada sebuah motor listrik dengan keakuratan yang tinggi. Motor berfungsi sebagai penggerak roda gigi agar dapat memutar potensiometer dan poros output-nya secara bersamaan

2.2. Rancangan Penelitian
Langkah langkah rancangan penelitian merupakan langkah untuk mempermudah dalam perancangan alat, dalam perancangan ini dibagi menjadi 3 tahap yaitu :
1. Rancangan diagram blok
Diagram blok untuk penggambaran sistem secara keseluruhan, yang memperlihatkan cara kerja dari rancangan Sistem, berikut ini adalah diagram blok yang digunakan
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               Gambar 1 Diagram Blok

Keterangan gambar :
1. Radio Frequency Identifaction (RFID)
Berfungsi sebagai input yaitu alat berupa kartu yang digunakan untuk mengakses sebuah pintu disuatu ruangan. RFID akan memberikan input data yang akan diteruskan ke mikrokontroler ATmega 328.
2. Mikrokontroler ATmega 8535
Mikrokontroler ATmega 328 bertindak sebagai pemroses data. Data yang diperoleh dari RFID akan diproses untuk mendapatkan output. Apabila RFID telah memberikan input, maka akan diperoleh output proses berupa notifikasi pada LCD dan Buzzer
3. Liquid Crystal Display (LCD)
LCD berfungsi untuk menampilkan keterangan akses pintu yang telah diatur. Jika RFID telah terdeteksi maka tampilan pada layar LCD akan muncul akses diterima.
4. Buzzer
Buzzer berfungsi sebagai alarm notifikasi untuk memberitahu bahwa akses telah diterima.
5. Solenoid
Katup solenoid akan tertarik jika ada tegangan dari relay dan memanjang jika tidak ada tegangan. Apabila akses diterima maka relay memberi tegangan ke solenoid dan pintu akan terbuka
2.3. Rancangan Hardware
1. Rangkaian RFID
Rangkaian RFID dalam perancangan ini sebagai alat utama yang diperlukan untuk membuat alat sistem keamanan pintu ini. Dimana RFID digunakan sebagai input untuk mengakses sebuah pintu ruangan
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           Gambar 2. Rangkaian RFID

Tabel 1. Koneksi Module RFID RC-522 ke Mikrokontroler
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2. Rangkaian LCD
Modul LCD 16x2 digunakan untuk menampilkan tulisan/karakter sebagai informasi. Pada alat ini informasi ditampilkan berupa tulisan akses diterima, jika RFID yang sebagai input dapat dikenal. Berikut rangkaian LCD seperti ditunjukkan pada Gambar  berikut
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Gambar 3 Rangkaian LCD

Koneksi penghubung antara LCD ke mikrokontroler dapat dilihat pada tabel berikut :

Tabel 2. Koneksi Modul LCD ke Mikrokontroler
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3. Rangkaian Buzzer
Buzzer akan berbunyi notifikasi jika kartu yang ditempel diterima. Berikut rangkaian Buzzer seperti ditunjukkan pada gambar  berikut :
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Gambar 4 Rangkaian Buzzer

Koneksi penghubung antara Buzzer ke mikro kontroler dapat dilihat pada  tabel berikut :

Tabel 3.Koneksi Buzzer ke Mikrokontroler
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4. Rangkaian Solenoid
Solenoid mempunyai katub yang bisa tertarik jika mendapatkan tegangan dari Motor DC. Berikut rangkaian Solenoid seperti ditunjukkan pada gambar  berikut.
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Gambar 5 Rangkaian Solenoid

Koneksi penghubung antara Solenoid ke mikrokontroler dan Driver Relay dapat dilihat pada tabel berikut :

Tabel 4. Koneksi Solenoid ke Mikrokontroler dan Driver Relay
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2.4. Rancangan Software
Mikrokontroler akan bekerja apabila di dalamnya terdapat sebuah program yang berisikan instruksi-instruksi yang akan digunakan untuk menjalankan seluruh sistem. Program tersebut akan menjalankan mikrokontroler secara bertahap karena terdapat set instruksi yang dimana setiap instruksi tersebut akan diproses sesuai dengan urutannya
Arduino IDE adalah software compiler yang khusus digunakan untuk arduino. Fasilitas yang disediakan cukup lengkap diantaranya meng-edit program, meng-compile program dan meng-upload program. Berikut adalah tampilan dari pembuatan program Arduino IDE:
1. Konfigurasi untuk jenis Arduino yang akan digunakan (Tools>Board>Arduino Uno)
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Gambar 6. Tampilan Konfigurasi Board

2. Setelah itu konfigurasi jenis Port yang akan digunakan (Tools>Port>COM9)
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Gambar 7 Tampilan Konfigurasi Port

3. Selanjutnya konfigurasi jenis pemrograman yang akan digunakan (Tools>Programmer> AVRISP mkll).
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Gambar 8 Tampilan Konfigurasi Program

4. Ketikkan program yang akan dibuat. Jika program telah selesai dibuat, cek apakah ada kesalahan atau tidak dalam penulisan program dengan cara klik Sketch>Verify(Ctrl+R). Jika benar maka tampilan akan seperti Gambar berikut :
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Gambar 9 Tampilan Done Compiling

2.5.  Perancangan Mekanik
Untuk membuat perancangan mekanik dapat dilakukan beberapa tahap  sebagai berikut: 
1. Tahap pengukuran Pada tahap ini dilakukan pengukuran pada bahan seperti mengukur lebar dan tinggi pintu agar dapat disesuaikan
2. Tahap Pemotongan Pada tahap ini semua bahan yang telah diukur kemudian dipotong sesuai yang diinginkan
3. Tahap Pembuatan Mekanik Pada tahap ini, LCD ditempel pada box yang akan dipasang pada sebelah pintu. Sedangkan RFID, Arduino, buzzer akan dipasang pada dalam box tersebut.
4. Tahap Perakitan Tahap perakitan yaitu memasang semua rangkaian dan mengatur tata letak rangkaian keseluruhan secara benar dan rapi.

2.6. Perancangan Penempatan Alat dan Pintu
Perancangan pintu beserta penempatan beberapa alat yang akan dibuat, bagian luar seperti RFID , LCD, dan Solenoid. Berikut gambar rancangan :
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Gambar 10 Perancangan Mekanik Pada Pintu Tampak Depan

3. HASIL DAN PEMBAHASAN
3.1. Perancangan Sistem
Pada tahap ini, model perancangan sistem yang digunakan adalah Unified Modeling Language (UML). Salah satu diagram UML yang digunakan adalah Use Case seperti gambar di bawah ini
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Gambar 11 Diagram Use Case

3.2. Pengukuran dan Pengujian Alat
Pengukuran dan pengujian alat dimaksudkan untuk mendapatkan data-data yang spesik dari alat yang telah dibuat sehingga mempermudah menganalisis kesalahan dan kerusakan yang akan terjadi pada saat alat ini bekerja. Berikut ini tahapan pengukuran dan pengujian alat :
1. Pengukuran Tegangan Pada Relay
Module relay digunakan sebagai switch solenoid doorlock pada sistem keamanan pintu otomatis menggunakan RFID berbasis mikrokontroler ini. Pengaktifan relay yang terhubung dengan solenoid dilakukan dengan memberikan tegangan 5 Volt DC pada kaki coil dan relay. Pengukuran dilakukan pada pin VCC dan pin GND pada relay.

2. Pengukuran Tegangan Pada Solenoid Doorlock
Solenoid doorlock akan bernilai aktif jika user berhasil melakukan scanning pada RFID reader tetapi solenoid doorlock tidak akan aktif jika user tidak berhasil scanning pada RFID reader. Titik pengukuran pada solenoid dilakukan pada pin power dan ground solenoid. Titik pengujian dapat dilihat pada gambar berikut
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Gambar 12 Titik Uji Solenoid

Hasil pengukuran tegangan Solenoid dapat dilihat pada tabel berikut

Tabel 5.Hasil Pengukuran Solenoid
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Dari hasil pengukuran tegangan solenoid doorlock diatas menunjukkan bahwa jika keadaan solenoid aktif maka nilai tegangan yang dihasilkan adalah 12 volt. Sedangkan jika solenoid dalam keadaan tidak aktif maka nilai tegangannya adalah 0 volt.

3. Pengujian Arduino dengan RFID Reader dan RFID Tag
Pengujian rangkaian pada tahap ini dilakukan dengan cara menghubungkan arduino ke catu daya dan menghubungkan pin-pin pada RFID ke pin-pin arduino secara benar. Pengujian ini bertujuan untuk mengetahui apakah modul ini bekerja dengan baik atau tidak
Pada tabel berikut memperlihatkan hasil pengambilan data jarak RFID Tag dengan sensor RFID Reader

Tabel 6.Hasil Pengujian Jarak RFID Reader dan RFID Tag
[image: ]Pada saat menempelkan RFID Tag ke RFID Reader yang telah diuji dapat terlihat pada gambar berikut
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Gambar 13. Menempelkan RFID Tag ke RFID Reader

4. Pengujian Arduino dengan LCD
Pengujian ini dilakukan untuk mendapatkan hasil dari RFID yang akan menampilkan notifikasi pada LCD yang berupa tampilan informasi tentang input yang terdeteksi dan tidak terdeteksi. Adapaun kode program arduino yang digunakan untuk menghubungkan arduino dan LCD sebagai berikut:
1. “lcd.setCursor(0,0);” adalah untuk mengatur kolom dan baris di LCD.
2. “lcd.print(“Tempelkan Kartu”);” adalah untuk menampilkan kalimat “Tempelkan Kartu” pada LCD.
3. “lcd.setCursor(0,1);” adalah untuk mengatur baris selanjutnya pada LCD.
Ini adalah tampilan LCD yang telah di uji
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Gambar 14 Tampilan RFID Tag Terdeteksi

Dan apabila RFID Tag tidak terdeteksi maka tampilannya akan seperti gambar berikut :
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Gambar 15 Tampilan RFID Tag Tidak Terdeteksi

5. Pengujian RFID Tag Dengan RFID Reader Dan Solenoid
Pengujian RFID Tag untuk membuka solenoid dilakukan dengan cara menempelkan RFID Tag pada RFID Reader yang bertujuan untuk mengetahui jarak RFID Tag dapat membuka pengunci pintu atau tidak.
Berikut hasil pengujian RFID Tag dengan Solenoid jika terdeteksi dan tidak terdeteksi dapat dilihat pada gambar berikut :
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Gambar 16 Pintu terbuka jika kartu terdeteksi
[image: ]











Gambar 17 Pintu tertutup jika kartu tidak terdeteksi

4. KESIMPULAN
Berdasarkan hasil perancangan dan pengujian yang telah dilakukan dapat ditarik kesimpulan sebagai berikut:
1. Kunci pintu otomatis dibuat dengan menggunakan RFID Tag dan reader, mikrokontroler Atmega 328 pada papan arduino uno, relay, buzzer, solenoid doorlock, serta MotorServo untuk membuka dan mengunci pintu.
2. Motor servo akan menarik pintu dan solenoid akan terkunci otomatis selama 5 detik setelah melakukan scanning RFID Tag ke RFID Reader
3. Error Dialog akan muncul ketika tag tidak dikenali oleh aplikasi.
4. Pendaftaran tag dan perubahan atau penambahan yang berhubungan dengan detail data karyawan hanya dapat dilakukan oleh admin.
5. Sistem absensi ini mempercepat dan mempermudah proses absensi karyawan serta tidak perlu lagi dilakukan proses perekapan data karena datanya sudah tersimpan dalam database
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2. Diagram Blok
Berikut ini terdapat diagram blok yang memperlihatkan cara kerja dari

rancangan Sistem Keamanan Pintu Menggunakan RFID Berbasis Arduino.

Adaptor

P QY B e
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Gambar 3.1 Diagram Blok Keseluruhan
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Gambar 3.2 Rangkaian RFID
Berikut adalah tabel koneksi penghubung antara RFID ke mikrokontroler
dapat dilihat pada Tabel 3.3.
Tabel 3.3
Koneksi Module RFID RC-522 ke Mikrokontroler @
Pin Module RFID RC- | Pin Board Arduino @
522 Uno c
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b. Rangkaian LCD

Modul LCD 16x2 digunakan untuk menampilkan tulisan/karakter
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Gambar 3.3 Rangkaian LCD

Berikut adalah tabel koneksi penghubung antara LCD ke
mikrokontroler dapat dilihat pada Tabel 3.4.
Tabel 3.4
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Pin Module LCD Pin Board Arduino Uno
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Berikut adalah tabel koneksi penghubung antara LCD ke
mikrokontroler dapat dilihat pada Tabel 3.4.

Tabel 3.4
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Pin Module LCD Pin Board Arduino Uno
GND (Hitam) Pin GND
VCC (Merah) Pin 5V
SDA (Orange) Pin A4
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c. Rangkaian Buzzer

Buzzer akan berbunyi notifikasi jika kartu yang ditempel diterima.

Berikut rangkaian Buzzer seperti ditunjukkan pada Gambar 3.4 berikut.
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Gambar 3.4 Rangkaian Buzzer.
Berikut adalah tabel koneksi penghubung antara Buzzer ke
mikrokontroler dapat dilihat pada Tabel 3.5.
Tabel 3.5
Koneksi Buzzer ke Mikrokontroler
Buzzer Pin Board Arduino Uno =
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d. Rangkaian Solenoid
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pada Gambar 3.5 berikut.
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Gambar 3.5 Rangkaian Solenoid

Berikut adalah tabel koneksi penghubung antara Solenoid ke

mikrokontroler dan Driver Relay dapat dilihat pada Tabel 3.6.
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e. Rangkaian Keseluruhan
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menggambarkan jalur dari alat sistem keamanan pintu yang akan dibuat.
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Abstrak


 


Sejak zaman dahulu p


intu merupakan 


alat pengaman 


 


penting dalam 


sebuah bangunan baik 


berupa 


rumah


 


atau bangunan yang lain seperti perkantoran dan lain lain


.


 


Terkadang untuk membuka 


dan menutup pintu rumah 


atau bangunan lain sering 


 


mengalami kesulitan.


 


Perkembangan teknologi 


saat ini dapat 


menggantikan pintu manual ini menjadi sistem otomatis.


 


Untuk mengantisipasi masalah 


keamanan 


 


perlu juga diperhatikan sist


em keamanan pintu otomatis. Penelitian ini merumuskan 


permasalahan bagaimana sistem pintu otomatis dan keamanan pintu dengan menggunakan RFID. 


Metode penelitian yang digunakan adalah riset dan pengembangan. Pintu Otomatis ini diprogram oleh 


aplikasi Arduin


o dengan membuat sistem keamanan menggunakan Radio Frequency indentification 


(RFID) sebagai gelombang radio frekuesi pembawa data yang akan diterima receiver. dan membrane 


keypad sebagai pengganti Card RFID bila user tidak membawa kunci. Hasil Penelitian i


ni berupa 


prototipe


 


yang menghasilkan f


itur yang ada dalam sistem tersebut antara lain Arduino sebagai 


Kontroler dan Passive Intra red sebagai antarmuka instruksi, Motor servo sebagai output


 


  


Kata


 


Kunci
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Ar


duino
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RFID,


 


Prototype


, otomatis


 


 


Abstract


 


Since the beginning of time, doors have been a vital component of safety in all kinds of constructions, 


including homes and other types of buildings like offices and others. It could occasionally be difficult to 


open and close a door to


 


a home or other building


. 


Recent technological developments have made it 


possible to replace this manual door with an automation system. In order to anticipate security 


difficulties, it's crucial to pay attention to the automatic door security system. This 


study formulates the 


problem of how to construct automatic doors and door security using RFID


. 


The research process used 


is research and development. In order


 


to program this automatic door, the Arduino application provides 


a security system using Radio Frequency Identification (RFID) as a data carrier radio frequency wave 


to be received by the receiver. if the user doesn't have a key on them, an RFID Card can 


be used instead 


of a membrane keypad.


 


A system prototype that uses an Arduino controller, passive infrared as an 


instruction interface, and servo motors as an output serves as a visual representation of the study's 


findings.
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1.


 


PENDAHULUAN


 


Sekolah merupakan salah satu sarana 


umum yang banyak dikunjungi orang, disisi 


yang lain saat ini kondisi pandemi yang 


belum sepenuhnya berakhir. Untuk 


meminimalkan kontak langsung d


engan 


benda seperti membuka dan menutup pintu


, 


maka diperlukan alat yang dapat membuka 


dan menutup pintu secara otomatis. 


 


Penggunaan teknologi sistem informasi 


menjadi kebutuhan manusia dan memberikan 


manfaat besar terhadap perubahan pada suatu 


struktur d


an manajemen organisasi (Firdaus, 
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